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Copyright © 2025, Nasdaq, Inc. All rights reserved. 

All content in this document is owned, or licensed, by Nasdaq, Inc. or its affiliates (‘Nasdaq’). Unauthorized use is 
prohibited without written permission of Nasdaq.  

While reasonable efforts have been made to ensure that the contents of this document are accurate, the document 
is provided strictly “as is”, and no warranties of accuracy are given concerning the contents of the information 
contained in this document, including any warranty that the document will be kept up to date. Nasdaq reserves the 
right to change details in this document without notice. To the extent permitted by law no liability (including liability 
to any person by reason of negligence) will be accepted by Nasdaq or its employees for any direct or indirect loss 
or damage caused by omissions from or inaccuracies in this document. 
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Revision Published Summary of Changes 

36.0 April 2024 Edition 36 – Added UploadPoolSequencePolicy instead of UploaderImportMessageEngine 
as Event pool policy. 

Added support for CoppClark Scheduled Task. 

37.0 August 2024 Added support for popup window for Data Uploader window 
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 NOTE: The Calypso License to use this Calypso Integration Module does not include a license for any 
third-party data services to which this module can interface. Clients are responsible for contracting with 
the appropriate third-party data service(s) prior to using this Calypso Integration Module. 
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1 Data Uploader Overview 
The Calypso Data Upload Framework (CDUF) simplifies importing data into Calypso. It supports many product 
types as well as certain reference data. 

CDUF supports the following trade lifecycle events: 

• New 

• Amend 

• Terminate (Partial and Full Termination) 

• Novate (PO, CounterParty, and Incoming Party. Partial and Full Novation) 

• Cancel 

• Undo Terminate 

• Exercise 

 

In addition to Trades, CDUF also supports uploading: 

• Books 

• Legal Entities 

• Corporate Actions 

1.1 Features 

• Full Lifecycle support - This supports the full lifecycle for trades, from New to Terminated. It also supports 
custom actions defined in workflows. 

• Calypso BO Message-based framework - This allows for extensibility by allowing customers to add their own 
validations via rules. This can also be customized to meet customer needs. 

• Trade Lifecycle Ordering - Trade lifecycle actions are played back in the same order as they are received. If 
one of the earlier actions cannot be applied due to a problem, all subsequent actions on the trade are blocked 
as well. 

• Error Reporting - All errors are available in the Task Station for review by your operations staff, or by Calypso 
operations staff on the SaaS implementations. 

• Replay Messages - Trades in errors are blocked as a message and can be played back when the underlying 
system error is corrected. 

• Native XML format - The Data Uploader has a native XML format. It supports multiple types of Keywords and 
Fees. 

• Acknowledgement Framework - In addition to Task Station integration, there is a publisher framework to 
interface with electronic Trade Capture systems, such as MarkitWire, to send acknowledgements and trade 
capture status to these systems. 
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• Calypso Termination API - The Data Uploader uses the Calypso Termination Extensions. As a result, it supports 
any extensions created by users and allows for configurable actions for Termination and Novation. 

• Validation Framework - All validations are done via Calypso BO Message rules. This allows a single code-base 
to be used for Validations and Actions across different incoming formats. For example, the Data Uploader 
supports inputs from MarkitWire, ICELink, CSV, as well as the Calypso Upload Document format (XML). All 
business validations are performed in one place. 

− The required effort to interface with a new trade capture is reduced to translating the new format to the 
Calypso Upload Document format (assuming the native XML supports those features). 

• Web Services – Please refer to the Calypso Data Uploader Developer’s Guide. 

• Extensions - The Framework supports extensions as follows: 

− New rules to handle customer-specific business rules. 

− Implementation teams can supply their own CSV formats convertors to create CSV upload files. 

Please refer to the Calypso Data Uploader Developer’s Guide. 

 As of version 17.0, REST APIs documentation is provided under the REST APIs page on the 
Documentation Portal and under /docs. 

1.2 Input Sources 

The following input sources are currently supported by the Calypso Uploader Framework 

• XML - Standardized Calypso Upload XML, also known as the Calypso Upload Document (CUD) format. 

 [NOTE: The Calypso Upload Document Format differs from Calypso ML format.] 

• MarkitWire - A new MarkitWire interface for IRD Swaps trades. Refer to the Calypso MarkitWire Integration 
Guide. 

• ICELink - Credit Derivatives Affirmation Interfaces. 

• CSV - Support for limited products in CSV format. Extendable by the implementation team. 

 [NOTE: The CSV format supports most common use cases. For complex objects and full coverage, please 
use the XML format. The XML format should be used for high performance integration] 

1.3 Supported Data 

The list of supported XML-format data can be found in “<calypso home>/docs/calypso-datauploader/Calypso 
DataUploader Coverage.xls”. 

 [NOTE: All features may not be covered for all data. Please review the formats and samples for supported 
features, and raise enhancement requests for any gaps] 
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• The “format” folder contains a description of the format for all supported data 

• The “sample” folder contains sample import files for all supported data 

1.4 Operations Overview 

The Data Uploader can be invoked by the File Watcher application (through the Data Uploader engine), by a 
Calypso engine, or manually using the scheduled task DATA_UPLOADER. 

The File Watcher monitors a specified folder at a specified interval, and when a new file is found, invokes the Data 
Uploader process. 

 [NOTE: The “watched” file directory and the interval between checks is user-configurable] 

Input files must be comma separated values (.CSV) or in the Calypso Upload Document (CUD) XML format. 
Examples of Calypso Upload Documents for data are available in “<calypso home>/docs/calypso-
datauploader/samples”. 

For CSV- and XML-formatted file, the file name must start with the data name. For example, the name of a CSV or 
XML file containing FX trades must begin with FX: “FX_20100226.csv”, “FX_1Q2010.xml”, etc. There are no 
restrictions on the remaining characters of the filename. 

The file extension indicates the format of the contents, CSV for a file containing data in comma separated values 
format, or XML for a file containing data in the Calypso Upload Document format. 

When a CSV file is loaded, the application converts it to the CUD using XSLT Transformation. The XML files are 
next processed into BO Messages, where they are validated before being processed into Trades and uploaded to 
the database. 

For trade data, the External Ref ID field must be unique. The Bundle Type and Bundle Name are generated on the fly. 
For example, in a file of fills for one order on an ECN, the Bundle Name can be the order number; the External Ref ID 
will represent the ECN Trade ID. 
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1.4.1 Manual Uploading 

To manually upload trades, launch the Data Uploader engine that runs the File Watcher application, and copy an 
input file into the folder specified in the configuration file. The File Watcher invokes the Calypso Data Uploader at 
the end of the current wait interval. You can also use the scheduled task DATA_UPLOADER. 

The Data Uploader processes the input file and creates an XML result file having the same base filename (e.g., 
FX_1Q2010) in the same directory. The result file contains details on the uploads, and depending on the outcome of 
that processing, either has a “.finished” or “.failure” file extension, to indicate success or failure, respectively. 

 [NOTE: Certain Calypso engines internally process incoming data into CUD format, making it ready for 
upload to the database without needing external files] 

1.4.2 Handling of Lifecycle Events 

Lifecycle Event Trade Data Keyword Action Fees Action 

NEW Save All Save All Save All 

AMEND OVERWRITE Overwrite Existing 
Keywords. 

Add New Keywords. 

Remove existing Fees and 
replace them from XML 

CANCEL Perform Basic Validation, do not 
Overwrite other trade data. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees and add 
new fees from XML 

TERMINATE Perform Basic Validation, do not 
Overwrite other trade data. 

Refer to the TERMINATION block 
for termination tags to perform the 
Termination. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees and add 
new fees from XML 

PARTIAL 
TERMINATE 

Perform Basic Validation, do not 
Overwrite other trade data. 

Refer to the TERMINATION block 
for termination tags to perform the 
Partial Termination. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees and add 
new fees from XML 

NOVATE Perform Basic Validation, do not 
Overwrite other trade data. 

Refer to the NOVATION block for 
novation tags to perform the 
Novation. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees and add 
new fees from XML 
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Lifecycle Event Trade Data Keyword Action Fees Action 

PARTIAL 
NOVATE 

Perform Basic Validation, do not 
Overwrite other trade data. 

Refer to the NOVATION block for 
novation tags to perform the 
Partial Novation. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees and add 
new fees from XML 

UNDO 
TERMINATE 

Perform Basic Validation, do not 
Overwrite other trade data. 

Overwrite Existing 
Keywords. 

Add New Keywords. 

Keep existing Fees. Ignore 
Fees from XML. Remove 
TERMINATION_FEES 

Basic Validation Validate that the book and counterparty of the Action matches those of the existing trade. 

1.4.3 General Notes 

• Adding an (non-unique) index for the External Reference column of the Trade Table can improve performance. 

• Adding an index on the Attribute Type + Attribute Value columns of the Message Attribute table can improve 
performance. 

1.4.4 Known Issues 

• When a Basis Swap is Partially Terminated in Calypso, the first Rate for the newly-created residual trade (i.e. the 
child trade) is cleared. This situation also applies to Cash Settlement information for Cap/Floor trades. 

This is a core Calypso issue and not a problem specific to other interfaces. 

1.5 Customizing the Data Uploader 

 Please refer to the Calypso Data Uploader Developer’s Guide for information on customizing the Data Uploader. 

 Important Note - The Data Uploader XSD is internal to the Data Uploader and cannot be used as an API. 
Between major versions, we cannot guarantee backward compatibility. 

For example, in 7.0.0 onwards we have changed the “trade id” related tags from type “int” to “long” and when 
migrating to version 7.0.0, you need to make sure that your custom code is changed accordingly. 
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2 Installation and Configuration 

2.1 Installation 

The Data Uploader is installed as part of the Calypso Installer when you select the “Data Uploader” optional 
module: 

 

 Please refer to the Calypso Installation Guide for complete details on the Calypso Installer. 

 

If you are installing a Calypso Upgrade package instead, the instructions are also in the Calypso Installation Guide. 

The deliverable contains the following directories and files in <calypso home>: 

client\bin\uploaderMQSeries.bat 

client\bin\dbscripts\GatewaySchemaBase.xml 

client\bin\dbscripts\GatewaySchemaData.xml 

docs\calypso-datauploader\Calypso DataUploader Coverage.xls 

docs\calypso-datauploader\format\ - (Spreadsheets containing annotated DUP messages) 

docs\calypso-datauploader\samples\ - (CSV and xml messages samples) 

docs\calypso-datauploader\schema\ - (XSD files) 

client\lib\calypso-cal-upload-x.x.x.jar 

client\lib\calypso-datauploader-x.x.x-x.x.x.x.jar 

client\lib\edtftpj-pro-3.1.2.jar 

client\lib\jdom-1.0.jar 

client\lib\license-files-x.x.x.zip - (Copies of third-party licenses) 
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client\resources\calypso_uploader_config.properties.sample 

client\resources\datauploader.properties.sample 

client\resources\GATEWAYMSG.wf 

client\resources\GATEWAYMSG_BACKLOADING.wf 

client\resources\gatewayservice.properties.sample 

client\resources\PLATFORMMSG.wf 

client\resources\sftpuploader.properties.sample 

client\resources\UploaderJMSAdmin.config.sample 

client\resources\UPLOADSOURCEMSG.wf 

2.1.1 Property Files 

Copy the property and configuration files to <calypso home>/tools/calypso-templates/resources. 

You will then need to deploy the files to your applications servers. 

 Please refer to the Calypso Installation Guide for details. 

You can modify “gatewayservice.properties” as needed (Optional). 

The application converts imported data into BOMessages, which require a Legal Entity for the Sender and Receiver. 

By default, “gatewayservice.properties” sets the Sender to CLIENT and the RECEIVER to CALYPSO. If these 
entities are not present as Legal Entities, Calypso will create them. 

To use a different Sender (i.e., Client) or Receiver (Host), modify the following lines in the file 
“gatewayservice.properties” as desired: 

2.1.2 Database Upgrade 

When you run Execute SQL as part of your installation, the Data Uploader files will be already loaded. You just need 
to check the “Gateway” checkbox. 

2.1.3 SWAPSWIRE_MAPPING Table Migration 

 [NOTE: Customers who are upgrading from older versions of SwapsWire/MarkitWire (prior to Calypso 
version 11.0) that made use of the SWAPSWIRE_MAPPING table must perform the steps in this section] 

Prior to using the Calypso Mapping window for MarkitWire, you must migrate any existing Swapwire mappings to 
the Calypso Mapping table. 

 [NOTE: Please follow the sequence below. Data loss can occur if the steps are not precisely followed] 

Step 1 – Contact Calypso Product Support to obtain the following migration scripts: 

• Oracle: sw_mapping_migration_oracle.sql 

• Sybase: sw_mapping_migration_sybase.sql 

The migration script copies all existing mapping data from the swapswire_mapping table to the calypso_mapping 
table. 
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Step 2 - Run Execute SQL with “SwapswireSchemaData.xml”. 

2.1.4 FRA Rounding 

You can set the default rounding method for uploaded FRA data by setting the value to UP, DOWN, or NEAREST in 
the domain “UploadDefaultRoundingMethod”. By default, uploaded data is rounded to NEAREST. 

2.1.5 Sec Finance Lifecycle Events 

The trade keyword EventTypeActionExternalRef is propagated to the transfer attribute defined in domain 
"SecFinance.EventTypeActionExternalRefName", or to the transfer attribute EventTypeActionExternalRef if the domain is 
not set. 

2.1.6 Access Permissions 

The Data Uploader enforces access permissions on imported data. 

 Please refer to Calypso Access Permissions documentation “Server Side Access Permissions” for complete 
details. 

Calypso has added support for SavePriceFromTradePriceReport Server Side Access Permissions, thereby allowing 
them to be enforced when using the Data Uploader: 

 SavePriceFromTradePriceReport 

 DeletePiceFromTradePriceReport 

2.1.7 Data Authorization 

This only applies to Core Calypso version 16.1 and above. 

The Data Uploader enforces data authorization (if data authorization is enabled on the system) for the objects 
defined in the domain “classServerAuthMode”, except for Is Admin users. 

The data upload will be successful but there will be a warning message as well as pop-up message stating that 
there are Pending Modifications. The user can then access the “Data Authorization” window to either accept or 
reject the Pending modifications. Once accepted, the respective objects will be saved into the database. 

For example: 

Here is after uploading Quote Object and if the authorization is enabled then, user get the following pop-up 
window: 
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Supported Objects 

Account 

AccountingRuleAccountConfig 

AccountingRule 

AccountingBookRuleLink 

AccountingEventConfig 

AccountInterestConfig 

AccountSweepingConfig 

Basket 

Bond 

Book 

Commodity 

CommodityReset 

Country 

CurrencyDefault 

CurrencyPair 

Fund 

FutureContract 

FutureOptionContract 

FXReset 

HolidayRule 
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LegalEntity 

ManualSDI 

PortfolioSwapContract 

StaticDataFilter 

SettleDeliveryInstruction 

QuoteValue 

Equity 

RateIndexDefaults 

LEContact 

CreditRating 

HolidayCode 

HedgeRelationshipDefinition 

MatchingAlias 

2.2 Calypso Mapping Window 

You can access the Calypso Mapping Window using Processing > Tools > Calypso Mapping (menu action 
mapping.CalypsoMappingWindow) from the Calypso Navigator. 

The Calypso Mapping window allows mapping data for various interfaces by providing the interface values and the 
corresponding Calypso values. 

 

Calypso has added new REST end point to export calypso mappings in CUD format based on query criteria 
interfaceName, Type, and interfaceValue. Following 3 query parameters can be used to filter out the results: 
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interfaceName - to fetch the mappings related to specific interface 

type - to fetch the mappings only for the specific type 

interfaceValue - to fetch mappings only for the specific interface value 

Users can search for various mapping results using the “Search” field. 

2.2.1 Reverse Default Functionality 

Calypso uses the table for reverse mapping values from Calypso to external interfaces (e.g., MarkitWire, etc.). In 
particular scenarios, multiple Interface (MarkitWire) values can have the same Calypso value. To map the default 
Interface value for a particular Calypso value, use the “Reverse Default” checkbox in the Calypso Mapping window. 

For example, for DayCount, the MarkitWire values, ACT/365.FIXED and ACT/365.ISDA both have the Calypso value, 
ACT/365. In the Markitwire Backloading process, the Calypso value is mapped to a single Markitwire value. To 
permit the user to choose one of these MarkitWire values as the default mapping, check the “Reverse Default” 
checkbox when mapping that value. With “Reverse Default” checked on the ACT/365.FIXED mapping, the 
BackLoading report for MarkitWire shows ACT/365.FIXED if the Calypso value is ACT/365. 

2.2.2 Access Permissions 

The following access permissions apply to the Calypso Mapping window: 

• ViewCalypsoMapping – Permission to view mappings. 

• ModifyCalypsoMapping – Permission to modify mappings. 

 

2.2.1 Calypso Mapping Audit 

(Optional) – You can enable Audit Reporting for Calypso Mapping by adding “CalypsoMapping” to the domain 
“classAuditMode”. 



Nasdaq Calypso 
Data Uploader Integration Guide / Version 15 – Version 18 

 

 

 

 

May 2025 Revision 39.0 / Approved Page 18 / 86 
Private and Confidential 

 

 

 Refer to Calypso Data Audit documentation for information on using the Audit Report. 

2.2.2 Mapping of Interfaces with Calypso Upload Document 

The Data Uploader provides two types of mapping: 

• Fix tag number to CUD xpath 

Interface value should be the Fix tag number and Calypso value should be CalypsoTrade xpath. 

There is a special case for NotesGroup since this is a repeating group. For NotesGroup mapping, the interface 
value should be "NotesGroup.(labelname)" and Calypso value should be the CalypsoTrade xpath. 

The mapping type name is "TradeMappings". 

• Fix tag number to Keyword name in CUD. 

Interface value should be Fix tag and Calypso value should be the keyword name. 

The mapping type name is "TradeKeywordMappings". 

 

To enable this functionality, you need to add the mappings translator. 

 

In this example, the functionality is enabled for "BloombergFIT" (source). 

The calypso value Fix represents the default translator to be used in the absence of source and format specific 
translator. 
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The mappings translator class is “<source> + <format> + MappingsTranslator”. If not found, then the class 
“<source> + MappingsTranslator” is used. And if not found “<format> + MappingsTranslator” is used. 

Currently the supported formats are Fix and Xml. Interfaces with XML data type need to put Calypso Value =Xml. 

Example of TradeMappings: 
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Example of NotesGroup Mapping: 

Tag 9613 of NotesGroup is populated in the TradeBundleName of CUD as per the mapping provided in the 
mapping table. 
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Example of TradeKeywordMappings: 

The TestKeywordName trade keyword is created in CUD with value same as tag 37 of the Fix message as per the 
mappings provided in mapping table for TradeKeywordMappings. 
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2.3 Workflow Configuration 

2.3.1 GATEWAYMSG Message Workflow 

“GATEWAYMSG.wf” provides a standard message workflow for GATEWAYMSG messages. 

 NOTE: Prior to importing the workflows, it is recommended that you create a backup of your existing 
workflows using File > Export all in the Workflow Configuration window. 

 NOTE: Please use the settings below or you will OVERWRITE your existing workflows. 

 

Step 1 – From the Calypso Navigator, navigate to Configuration > Workflow > Workflow. 

 

Step 2 - In the Workflow Configuration window, choose File > Import current. 

 

Step 3 - Select the following settings: 

• Processing Org = ALL 

• Event Class = PSEventMessage 

• Subtype = GATEWAYMSG 

• Product = ALL 

 

 

Step 4 - Click Apply. The confirmation window appears: 
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Step 5 - Click Yes to import or No to abandon the operation. 

If you click Yes, use the file browser to select the file “GATEWAYMSG.wf”. 

 

If you are updating an existing Data Uploader instance, the application displays a confirmation message: 

 

Click Yes to continue the import operation. The application imports the workflows and then displays a message 

showing what actions were accomplished: 
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The Gateway Message workflow is now available: 

 

 

 

Step 6 - You need to add the FORCE_NEW action manually to the GATEWAYMSG workflow: 

PENDING_VALID – FORCE_NEW – PENDING_VALID with the workflow rule “ForceNew” 

The FORCE_NEW action is a manual action that can convert the AMEND subaction to the NEW subaction. 
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Step 7 – (Optional) You can add the FORCE_AMEND action as needed to the GATEWAYMSG workflow: 

PENDING_VALID – FORCE_AMEND - PENDING_VALID with the workflow rule “ForceAmend” 

The FORCE_AMEND actions forces an amend on a trade for instances when the interface is down and a trade is 
entered using a manual link to an existing MarkitWire trade in Calypso. 

 

If a trade with given External Reference already exists in Calypso, then a new MarkitWire trade will not be uploaded 
to Calypso. Such a trade will fail with exception task “Trade Already exists with External Reference: 
MW_CALYPXXXX_1234567” and the GATEWAYMSG remains in PENDING_VALID state. 

To replace the existing trade with the new MarkitWire trade, manually apply the FORCE_AMEND action on the 
GATEWAYMSG. The action results in the Calypso trade be forced from the NEW subaction to the AMEND 
subaction, and the MarkitWire trade will then be uploaded into Calypso with the AMEND action. 
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2.3.2 KickOff/CutOff Config (for Local Mode Only) 

Users should configure KickOff/CutOff for GATEWAYMSG workflow for use in Local mode. For setting up 
kickoff/cutoff, please refer to below steps and sample snapshot for configurations. 

 

From PENDING status have a STP transition for kickoff/cutoff workflow. The ‘Use Kick Off / Cut Off’ must be 
enabled on this transition and it must have following message rules: 

• CheckKickOff 

• CheckCutOff (if cut-off enabled) 

• UploadReprocess – This is specific to Uploader in Local mode and should only be used if you are using Kick-Off 

It is advisable to keep this (kickoff/cutoff) transition of low priority (shown as 2 above), so that other STP transition 
passing from this status are given first preference. 

 

1. Kick Off /Cut Off Config:  

For any kickoff/cutoff, user needs to specify its kick-off and cut-off time. For set-up and to know more about these 
configurations, please refer to the Calypso workflow setup guide.  

For Uploader kick-off/cut-off, the configuration must have 

a. Method as ‘ALL’ 
b. Date Calculator as ‘Uploader’  



Nasdaq Calypso 
Data Uploader Integration Guide / Version 15 – Version 18 

 

 

 

 

May 2025 Revision 39.0 / Approved Page 28 / 86 
Private and Confidential 

 

It is recommended to have a kick-off time of more than 2 minutes. 

 

Sample snapshot for Kickoff/Cutoff config:   

 

 

 Note: In the case of local mode, new tasks are created for each KickOff, marking the previous tasks as 
complete. As new tasks are created, Scan Frequency parameter is not used. Similar behavior is achieved 
by setting KickOff and CutOff. 

 

For example: - to reprocess every 2 minutes and to stop the reprocessing after 10 minutes, please configure the 
following- 

KickOff=2, CutOff=10 

Scan Frequency can be left 0 or any other value. It is not used. 

Effectively, KickOff is the frequency for reprocessing, CutOff is the total time after which the kick offs should be 
stopped. 
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2.3.3 Trade Workflow 

 

Workflow Rules 

Termination, Novation, and Cancellation Trade workflow rules must be set in the Trade workflow for the products 
for which you use the Data Uploader, or for ALL. 

Step 1 – On the VERIFIED – TERMINATE - TERMINATED transition, add the UpdateTermination workflow rule. 

 

 

Step 2 - On the VERIFIED – CANCEL - CANCELED transition, add the Cancel workflow rule. 

 

 

Step 3 – On the TERMINATED – UNDO_TERMINATE – VERIFIED transition, click Custom Rules Definition to create the 

custom rule CustomUploaderUndoTerminationRule: 
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Set the custom rule as a combination of the rules UpdateUndoTermination and Reject. 

 

Then add the rule CustomUploaderUndoTerminationRule on the TERMINATED – UNDO_TERMINATE – VERIFIED 
transition. 
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 NOTE: Any changes to the BO Message workflow rules must be reflected in the file 
“gatewayservice.properties” to indicate which status codes are used for blocking messages. These 
are used to link together the BO Messages. 

 

Domain Values 

A number of domain values need to be added. 

• Add GATEWAY to the domain “exceptionType” 

 

• (Optional) Add the termination action to the domain “UploadTerminateAction”. The default action is 
TERMINATE if not set. 

• (Optional) Add the novation action to the domain “UploadNovateAction”. The default action is TERMINATE if 
not set. 

• Add the action to apply when you must exit from an outside trade (e.g., a MarkitWire trade) to the domain 
“UploadExitAction”. This action will affect the upstream trade outside Calypso. 

• (Optional) Set the default termination reason in the domain “UploadTerminationReason”. The default is 
Assigned if not set. 

• (Optional) Set the default novation reason in the domain “UploadNovationReason”. The default is Assigned if 
not set. 

 NOTE: If you modify the default actions, you need to define those actions in the Trade workflow as well, 
with the corresponding workflow rules 

2.4 Task Station Setup 

From the Calypso Navigator, navigate to Processing > Task Station to bring up the Task Station. 

Then add reports for GATEWAY exception events and GATEWAY message events. 
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GATEWAY Exception Events 

 

 

 

GATEWAY Message Events 
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2.5 Pricing Environment 

The Data Uploader engine and the Uploader Import Message engine use the pricing environment from the Engine 
Config by default. If the pricing environment is not provided in the Engine Config, the pricing environment is picked 
up from the User Defaults. If the pricing environment is not specified in the User Defaults, the Pricing Environment 
named “default” is used (if any). 

2.6 Uploader Import Message Engine Configuration 

Incoming messages are automatically imported using the Uploader Import Message engine (an extension of the 
Import Message engine). It is triggered by an IEAdapterListener listening to an IEAdapter. Each time a new message 
is detected by the adapter, it calls the engine which saves the incoming message into Calypso as a GATEWAYMSG 
following the workflow previously defined. 

2.6.1 Engine Configuration 

The Uploader Import Message engine is configured in the Engine Manager of Web Admin: event subscription and 
engine parameters. 

You may need to add this engine if it is not available for configuration: Create a new engine called 
UploaderImportMessageEngine with class name com.calypso.tk.engine.UploadImportMessageEngine. 

Make the UploaderImportMessageEngine a consumer of the events: 

• PSEventUpload 

Select the event class “PSEventUpload” from the ‘Persisted Event Configuration’ field and click  to add it to the 
box area. 

The "config" engine parameter (configuration attribute) is config = Uploader 

 

UpdateManagerEngine is used for reprocessing messages. In case of Bulk-upload, it will process 
uploadRequestMessages and it will create uploadResponseMessages. 
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2.6.2 Domain Values 

From the Calypso Navigator, navigate to Configuration > System > Domain Values to add 
“tk.util.UploadPoolSequencePolicy” to the domain “engineEventPoolPolicies”. 

 

You also need to add “UploadPoolSequencePolicy” to the domain “engineEventPoolPolicyAliases”, with the 
Comment = “tk.util.UploadPoolSequencePolicy”. 

 

2.6.3 Engine Parameters 

Set the following engine parameters using the Engine Manager in Web Admin: 

• EVENT_POOL_POLICY = UploadPoolSequencePolicy. 

• config = Uploader 

For property file “calypso_uploader_config.properties”. 
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2.6.4 Environment Properties 

When using Upload Import Message Engine to consume messages from queues, the message size is limited by 
environment property EVENT_LIMIT_SIZE. The default value is 1MB so you may need to increase it as needed. 

RESTART_ATTEMPTS controls the number of restart attempts by the Uploader Import Message engine if the 
connection is lost with MQ (default is 10). 

RESTART_DELAY is the delay between attempts (in seconds, default is 5). 

2.6.5 Property File 

The property file “calypso_uploader_config.properties” has a number of properties to deal with the 
Uploader Framework. 

# Import Message Engine (MQ) 

input.queue.name=dynamicQueues/input 

dynamicQueues/input.queue.setContext=true 

 

# Sender Engine (JMS) 

 

#For ActiveMQ 

jms.url=tcp://localhost:61616 

jms.modetypeclass=org.apache.activemq.jndi.ActiveMQInitialContextFactory 

jms.queue.connectionFactory=ConnectionFactory 

 

#For IBMMQ 

#jms.url=file://localhost/c:/tools/ibm/mqs/binding 

#jms.modetypeclass=com.sun.jndi.fscontext.RefFSContextFactory 

#jms.queue.connectionFactory=QueueConnectionFactory 

 

output.queue.name=dynamicQueues/output 

dynamicQueues/output.queue.ackType=auto 

dynamicQueues/output.queue.persist=true 

dynamicQueues/output.queue.transacted=false 

 

#the following property can be used to indicate what mode to be used when using the uploader 

framework 

uploadMode=Local 

persistMessages=Failure 

The uploadMode property indicates which mode to use when utilizing the Uploader Framework. The possible 
values are Local and LocalAPI. 

 NOTE: BOMessage is deprecated and no longer supported. 
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• Local (recommended mode for best performance) – All processing occurs on the client side. The property 
persistMessages controls whether BO Messages are created or not. 

− persistMessages=All – A BO message is created for every external message. Failed Messages are 
reprocessed by applying REPROCESS action, which generates an event for the Update Manager Engine 
for reprocessing (see setup details below). 

− persistMessages=None – No BO Message is created (same as using uploadMode=LocalAPI). The 
Import Message Engine sends the Acknowledgment to the “output.queue.name” obtained from its 
configuration. If “output.queue.name” is not configured, no acknowledgement is sent. 

− persistMessages=Failure – A BO Message is created only when there is a validation failure in saving the 
trade. Failed messages are reprocessed by the Update Manager engine (see setup details below). 

In Local mode, the uploader caches the Pricing Environment, and the property ‘PricingEnvCacheSize’ in 
‘gatewayservice.properties’ is used to determine the size of the cache. 

# Determines the size of cache to hold PricingEnv, by default its size is 10. 

PricingEnvCacheSize=10 

Pricing Environment is required to be loaded by the uploader, when uploading certain trade types like FX and 
Bonds, and loading the pricing environment for every trade that is uploaded will consume a lot of time and 
hence uploader framework when run in ‘Local’ mode caches the pricing environment, so that the trades can be 
uploaded without consuming lot of time. 

This property indicates the number of pricing environments to be loaded in the cache. And when the cache size 
reaches the value of this property, the least recently used item will be removed from the cache. 

• LocalAPI – This is Similar to uploadMode=Local, and persistMessages=None. LocalAPI is deprecated and will 
not be supported in the coming releases. Use the Local mode to upload. All processing occurs on the client, and 
caches are built and used to improve performance. No BO Message is created. 

You should increase the Number of Threads in the Engine configuration to the number of available cores to 
improve performance. 

 

 NOTE: To switch to uploadMode=Local on an existing implementation, you need to: 

• Make sure to either COMPLETE or CANCEL any pending BO messages and consume all the events related 
to PSEventRepublish. 

• Run the schema data with (GatewaySchemaBase.xml and GatewaySchemaData.xml). 

• Import the workflows GATEWAYMSG.wf and UPLOADSOURCEMSG.wf as they have been modified. 

• Get latest datauploader and gatewayservice properties. Change the properties in configuration files as 
explained above. 

• Configure the Update Manager Engine - UploaderPublishEngine is no longer needed when using the 
uploadMode=Local. All these events will be handled by UpdateManagerEngine.] 

 

Enabling SSL for IBM MQ 
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SSL connectivity with CipherSuite enabled only works with the following versions of IBM MQ, and NOT on lower 
versions: 7.0.1.13+, 7.1.0.7+, 7.5.0.5+, 8.0.0.2+, 9.1.x.x+. 

The following properties need to be added in “calypso_uploader_config.properties” to enable SSL for IBM MQ: 

#IBM SSL Support 

sslVersion=TLSv1.2 

sslKeystore=keystore.jks 

sslKeystorePassword=<password> 

sslTrustStore=truststore.jks 

sslTrustStorePassword=<password> 

#sslTrustStoreAlgorithm= 

#sslKeystoreAlgorithm= 

sslCipherSuite=TLS_RSA_WITH_AES_256_CBC_SHA256 

 

The SSL functionality does NOT work with JNDI. Connection must be done via those properties. 

 

Also, when running the Uploader Import Message Engine, please add the following argument to engineserver.bat: 

-Dcom.ibm.mq.cfg.useIBMCipherMappings=false 

 

Lost Messages when persistMessages=None 

When a message is not delivered and an event is not created in Calypso, the message will go to the Dead Letter 
Queue. 

You can check failed messages from that queue. 

You need to have the following properties in “calypso_uploader_config.properties”: 

input.queue.name=dynamicQueues/input 

dynamicQueues/input.queue.transacted=true 

And while sending data from MQ, the "Persistent Delivery" flag should be checked. 

 

 

 

2.6.6 Sender Engine Configuration 

Add the following items to the Message Sender configuration. 

From the Calypso Navigator, navigate to Configuration > Messages & Matching > Message Sender. 
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Message Status Product 
Type 

Advice Type Address 
Type 

Gateway Send Sender 
By 
Gateway 

PENDING ALL GATEWAYMSG Uploader Uploader   

PENDING_TRADE ALL GATEWAYMSG Uploader Uploader   

PENDING_VALID ALL GATEWAYMSG Uploader Uploader   

COMPLETED ALL GATEWAYMSG Uploader Uploader   

 

When the domain PersistBOMessageForStaticDataErrors is set to true, SenderEngine generates NACK for rejected 
static data. 

Avoid repeating NACK in case of Kick-Off (For Local Mode only) 

To stop from sending repeating ack/nack each time message is reprocessed (and still fails), user needs to create a 
static filter that checks for message action is not ‘REJECT’, as shown below. This static filter must be set onto the 
MessageSenderConfig of GATEWAYMSG for message status as ‘PENDING’. 
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 Note: For Sender Engine please refer to documentation for setting up SenderEngine. 

2.6.7 Running Multiple Instances of the Import Message Engine 

The Data Uploader module can read messages from external messaging systems using the JMS API through the 
Import Message engine. 

By default, the Import Message engine uses config = Uploader based on the property file 
“calypso_uploader_config.properties”, which indicates the queue names to connect to. 

But it is also possible to run the Import Message Engine using config = TradeUploader. Additionally, multiple 
instances of the import message can be configured, each with its own property file to connect to different 
messaging systems. This allows for handling of messages from different sources, such as, Kafka, IBMMQ, or 
ActiveMQ, without needing custom classes. 

 

Property File 

Add the property file  

For ex: 

calypso_tradeuploader_config.properties. 

Domain values 

Add the config name to the domain “gateway” so that when sending acknowledgements for that message, the 
IEAdapterConfig is initialized from the message's gateway, and the acknowledgement will be sent to the proper 
queue. 
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Add the config name to the domain “addressMethod”. 

 

 

Engine Config 

Add an engine configuration: 

 
TradeUploader 
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Kafka 

 

 

IBMMQ 
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ActiveMQ 

 

 

Sender Config 

Add a Sender Configuration as below: 

 

You can now run each instance of the Import Message engine as needed. 
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2.6.8 Using the Update Manager Engine 

The Update Manager engine is only needed for uploadMode=Local, and persistMessages=All or 
persistMessages=Failure. 

It handles the reprocessing of the failed messages that are reprocessed by applying REPROCESS action. 

Engine Configuration 

The Update Manager engine is configured in the Engine Manager of Web Admin: event subscription and engine 
parameters. 

It subscribes to PSEventUploadReprocess events. 

You may need to add this engine if it is not available for configuration: Create a new engine called 
UpdateManagerEngine with class name com.calypso.tk.engine.UpdateManagerEngine. 

Event filter = UpdateManagerEngineEventFilter 

 

 Please refer to Calypso Web Admin documentation for complete details. 

 

Starting the Update Manager Engine 

The Update Manager engine can be started from the Engine Manager in Web Admin. 

 Please refer to Calypso Web Admin documentation for complete details. 

 

Reprocessing Bloomberg VCON Messages for Missing Bonds 

Importing Bond definitions using Bloomberg DL engine in case the message fails to upload because of missing 
Bond. 

To achieve this, we require the following engines: 

• UpdateManagerEngine 

• Bloomberg Engine 

And following message rules: 

• UploadReprocess 

• RequestBloomberg 

 

The Bloomberg Engine is used for fetching the Bond: 
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In Engine Configuration, the UpdateManagerEngine is configured for reprocessing the Pending GATEWAYMSG: 

 

 

UploadReprocess and RequestBloomberg message rule in the workflow 
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Example: 

We are uploading a VCON message, and it fails because of missing bond in the system: 

 

 

We see the GATEWAYMSG will remain in Pending state as shown below: 
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Now the GATEWAYMSG need to be reprocessed. On reprocessing the GATEWAYMSG, RequestBloomberg 
Message rule will create an even for Bloomberg Engine to fetch the Bond. 

However, the GATEWAYMSG will remain in Pending state because still the Bond is not present in the system: 

 

 

In the next reprocess of the GATEWAYMSG, the message will move to Completed state as bond is imported by the 
Bloomberg Engine and Trade is created: 

 

 

The reprocessing of the Pending GATEWAYMSG can be done manually or automatically by configuring kickoff and 
cutoff for the WF transition. 

With the help of kickoff and cutoff the complete process will work without manual intervention. 

2.7 Using the Data Uploader Engine 

The Data Uploader engine is only used for manual uploads of CSV or XML files. It starts the File Watcher application. 

2.7.1 Property File 

The file “<calypso home>/client/resources/datauploader.properties” contains the File Watcher 
properties – Modify as needed. 
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# This is the encoding scheme to be used for the INPUT (i.e. CSV) files 

# This feature is provided to take care of CSV files created using different  

# encoding schemes e.g. SHIFT_JIS for Japanese 

INPUT_ENCODING_SCHEME=UTF-8 

 

# This is the encoding scheme for the output of the CSV uploader. 

# The CSV uploader creates an XML file that is read by the XML uploader 

# The output scheme instructs the CSV uploader to create the output XML from  

# the CSV uploader 

# (input for the XML uploader) in this encoding scheme 

OUTPUT_ENCODING_SCHEME=UTF-8 

 

# File Watcher Properties 

#This is the folder where we place the files. 

fileDir=C:\\uploader\\ 

interval=10000 

 

#is the time to sleep after receiving the file before actually processing the file 

sleepInterval=15000 

 

# This tells the file watcher to call the XML Uploader 

fileWatcherType=data 

 

#This tells the file watcher to monitor CSV & XML Files only 

fileFilter=csv,xml,txt 

csvDelimeter=, 

txtDelimeter=\t 

 

#If the following property is true, the transformation files will be generated in 

CALYPSO_HOME\DataUploader folder 

DEBUG_XML=true 

uploadMode=Local 

persistMessages=All 

2.7.2 Launching the Data Uploader Engine 

The Data Uploader engine is configured in the Engine Manager of Web Admin: event subscription and engine 
parameters. 

You may need to add this engine if it is not available for configuration: Create a new engine called 
DataUploaderEngine with class name com.calypso.tk.engine.DataUploaderEngine. 

The "config" engine parameter is config = datauploader.properties 

 

The Data Uploader engine can be started from the Engine Manager in Web Admin. 
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 Please refer to Calypso Web Admin documentation for complete details. 

 

Operating Considerations 

Based on your volume, you may need to increase the memory allocated to the Data Uploader engine 
(e.g., -Xmx384, -Xmx512). 

With the Data Uploader engine operating, you can then place a file to import in the watched directory (specified by 
fileDir). At the end of the current wait interval, the File Watcher will notify the Data Uploader which will then process 
the file accordingly. 

The Task Station will display any errors that may occur. 
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2.8 Using the Scheduled Task DATA_UPLOADER 

You can also upload files manually using the scheduled task DATA_UPLOADER. 

From the Calypso Navigator, navigate to Configuration > Scheduled Tasks (menu action 
scheduling.ScheduledTaskListWindow), and create a task of type DATA_UPLOADER. 

 

 

Task Attributes 

• INPUT_FILE_LOCATION – Location of the file to be imported. 

• INPUT_FILE – File name. 

• OUTPUT_LOCATION – Location of the converted file. 

• INPUT_ENCODING – Encoding scheme to be used for the file to be imported. 

• OUTPUT_ENCODING – Encoding scheme to be used for the converted file. 

• RENAME_INPUT_FILE – Select true to rename the imported file so that you know it has been imported. 

• UPLOAD_SOURCE – Select the source of the file to be imported. 

• UPLOAD_FORMAT – Select the format of the file to be imported. 

 

You can also enter regular expressions for the attributes INPUT_FILE_LOCATION, INPUT_FILE, 
OUTPUT_LOCATION. 

Examples: 

INPUT_FILE_LOCATION = ${user.home}\datauploader\input 

INPUT_FILE = Futures_[0-9]{1}.xml 
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OUTPUT_LOCATION = ${user.home}\datauploader\output 

Upon import, the following files are created: 

In INPUT_FILE_LOCATION – “<file name>.finished” to indicate that the file has been imported. 

In OUTPUT_LOCATION: 

• “<fine name>_result.xml” to show the items successful imported. 

• “<file name>_rejected.xml” to show the rejected items. 

The rejected file is created if Publishers=File,RejectedFile in “datauploader.properties”. 

2.9 Resources Files 

IMPORTANT NOTE: 

All resource files, property files and configuration files that have been modified need to be copied to <calypso 
home>/tools/calypso-templates/resources. 

You will need to re-deploy your environment to your application servers so that they can be included. 

 Please refer to the Calypso Installation Guide for details on deployment. 

2.10 Dates Format 

For proper date-time conversion, a date should contain the following information: Date, Time, Timezone offset. 

Example: Date = 20170602T16:12:39+05:30 (where +05:30 is the timezone offset with respect to GMT) 

If the timezone is not specified, the Data Uploader uses the system timezone. 

The DataUploaderEngine uses the EngineServer timezone by default. 

The Data Uploader window uses the User Default timezone. 

2.11 Fees Management 

When uploading a trade amendment with no trade fees in the uploaded file, the trade fees are not removed - There 
is no change to the trade fees. 

To remove the fees when there are no fees in the uploaded file, you need define the product types for which you 
want to remove fees in the domain “UploaderRemoveFeesForProduct”. 

If you want to preserve some fees when domain “UploaderRemoveFeesForProduct” is set, you can add the fee 
types to the domain “UploadPreserveFee”. 

Example: Cash is set in domain “UploaderRemoveFeesForProduct”, and domain “UploadPreserveFee” contains 
FEE2. A Cash trade has 2 fees, FEE1 and FEE2, and an amendment is uploaded with no fees. After the amendment, 
FEE1 is removed and FEE2 is preserved. 
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3 Operations 

3.1 Requirements 

Before using the Data Uploader, the Data Server, Event Server, and Task engine must be running. Additionally, you 
must monitor the Task Station for errors and blocked messages. 

3.2 Handling Blocked Messages 

In the event of a blocked message, after clearing the issue, you can use the VALIDATE or LOAD action to re-
process a manually uploaded message. For messages received from an engine, use the action appropriate for that 
system. 

For example, after clearing an issue for a blocked MarkitWire message, use the REPROCESS action to resubmit the 
message to the system. 

For messages from external systems, refer to the specific Calypso integration guide for that system. 

3.3 Task Station Errors 

If Task Station error messages are improperly displayed, ensure that the file “ErrorBundle.properties” is present in 
the resources directory. 

3.4 Trade Allocations 

Allocation in the Data Uploader is performed in two modes.  

• API Mode: In this mode a trade in Calypso will be allocated using the Allocation API in Calypso, and the child 
trades are created when the action is applied. The child trades are rekeyed (external reference is updated to 
match the external system) when the child trade notifications are received in calypso. This is used when 
external system is sending the allocation information to Calypso and we use the percentages or notionals to 
create the allocations. 

• Non-API Mode: This use case comes across when allocations are done externally in a system and we only 
receive the block trade and the post-allocated trade. But not the actual allocation details itself. In this mode 
allocation is not be performed in Calypso using the Allocation API. Only the status of the block trade will be 
updated to ALLOCATED, by directly calling Allocate action. We will then also create the child trades in Calypso 
(which are passed from the external system) and then link up the trades. 

 

The Uploader schema is extended to support Trade Allocations. 

The Following sample xml defines that the trade is to be allocated into 2 child trades with amounts 1000 & 2000 
respectively. 



Nasdaq Calypso 
Data Uploader Integration Guide / Version 15 – Version 18 

 

 

 

 

May 2025 Revision 39.0 / Approved Page 52 / 86 
Private and Confidential 

 

<TradeAllocations> 

 <TradeAllocation> 

  <AllocationAmount>1000</AllocationAmount> 

  <AllocationPercentage></AllocationPercentage> 

  <AllocationParty>CALYPSO1</AllocationParty> 

  <AllocationPartyRole>CounterParty</AllocationPartyRole> 

  <ChildTradeExternalReference>Child_IRS_Trade_1</ChildTradeExternalReference> 

 </TradeAllocation> 

 <TradeAllocation> 

  <AllocationAmount>2000</AllocationAmount> 

  <AllocationPercentage></AllocationPercentage> 

  <AllocationParty>CALYPSO2</AllocationParty> 

  <AllocationPartyRole>CounterParty</AllocationPartyRole> 

  <ChildTradeExternalReference>Child_IRS_Trade_2</ChildTradeExternalReference> 

 </TradeAllocation> 

</TradeAllocations> 

 

The <TradeAllocations> structure should be used with <Action>ALLOCATE</Action> when you want the trade to 
be allocated in calypso, otherwise just the trade is uploaded with action <Action>ALLOCATE</Action> 

Please Check the samples on how these approaches are used. 

Once the Allocation is performed, the child trades are created and the External Reference of the child trades needs 
to be REKEYED, so that they can be used in the further life cycle actions. 

Child trades can be rekeyed in 2 ways. 

• At the time of Allocation 

While Allocating the Trade in the <TradeAllocations> block pass the External Reference for each Child trade in 
the tag < ChildTradeExternalReference>, The child trade's external reference will be changed accordingly. 

• After the Allocation 

Using <CalypsoTrade> xml with <Action>ALLOCATION_REKEY</Action>. The Parent Trades external 
Reference and the New External Reference has to be passed, then uploader will find out the child trades from 
the parent trade and find the appropriate child trade by matching the counterparty in case of counterparty 
allocation & book in case of book allocation. Please refer to samples for more examples. 

 

<CalypsoTrade> 

 <Action>ALLOCATION_REKEY</Action> 

<!-- 

 other tags 

--> 

 <TradeKeywords> 

            <Keyword> 
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                <KeywordName>NewExternalRef</KeywordName> 

                <KeywordValue>NEW_XCCY_CHILD_AFTER_ALLOCATION01</KeywordValue> 

            </Keyword>    

            <Keyword> 

                <KeywordName>AllocatedFrom</KeywordName> 

                <KeywordValue>ParentTradeExternalReference</KeywordValue> 

            </Keyword> 

        </TradeKeywords> 

</CalypsoTrade> 

 

CSV Support 

The following columns need to be added to support the Allocations in the existing CSV files. 

 

Allocation_AllocationAmount,Allocation_AllocationPercentage,Allocation_AllocationParty,Allocation_AllocationPartyR
ole,Allocation_ChildTradeExternalReference 

1000,0.02,CALYPSO,CounterParty,Child_IRS_Trade_2 

Repeat these columns in the same order, for every allocation child to be created. 

 

Workflows 

Add the UpdateAllocationChild rule between VERIFIED and ALLOCATED, which is mandatory for setting the 
external references on the child trades. 

Please Note that the rule UpdateAllocationChild must be present wherever ALLOCATE action is applied as follows. 
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Make sure that you have configured your Calypso trade workflow to handle the allocation of a block trade along 
with the generic lifecycles for block and child trades which are described in the Calypso Allocation Documentation. 

 

Calypso Recommends the following: 

Original Status Action Rules Resulting 
Status 

Comments 

VERIFIED ALLOCATE CheckFullAllocation 

CheckValidAllocation 

ALLOCATED Primary transition for fully allocating 
a trade. 

Mandatory for 
performing allocations. 

ALLOCATED AMEND CheckFullAllocation ALLOCATED For making amendments to a block 
trade. 

The action is propagated to the 
child trades through the action 
specified in domain 
PropagateBlockTradeChangesActio
n - See PROPAGATE action below. 

ALLOCATED ALLOCATE CheckFullAllocation 

CheckValidAllocation 

ALLOCATED Transition for updating the block 
trade when child trades are directly 
modified. 

Optional if you do not allow direct 
child trade modification - 
See Modification of Child Trades for 
details. 

PARTIAL_ALLO
C 

ALLOCATE CheckFullAllocation 

CheckValidAllocation 

ALLOCATED Transition for completing the 
allocation of a partially allocated 
trade. 

VERIFIED ALLOCATE CheckPartialAllocatio
n 

CheckValidAllocation 

PARTIAL_ALLO
C 

Primary transition for partially 
allocating a trade. 

ALLOCATED ALLOCATE CheckPartialAllocatio
n 

CheckValidAllocation 

PARTIAL_ALLO
C 

Transition for taking a fully allocated 
trade to partially allocated by 
changing the children. 

ALLOCATED AMEND CheckPartialAllocatio
n 

PARTIAL_ALLO
C 

Transition for taking a fully allocated 
trade to partially allocated by 
modifying the block trade. 

The action is propagated to the 
child trades through the action 

https://www.calypso.com/download/helpdesk_test1/documents/rel1300/docs/Subsystems/TradeLifecycle/Content/AllocationWorkflow.htm#Modifica
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Original Status Action Rules Resulting 
Status 

Comments 

specified in domain 
PropagateBlockTradeChangesActio
n - See PROPAGATE action below. 

ALLOCATED UPDATE CheckPartialAllocatio
n 

CheckValidAllocation 

PARTIAL_ALLO
C 

Transition for taking a fully allocated 
trade to partially allocated by 
updating the block trade - This 
action is applied on the block trade 
when the allocation is modified. 

PARTIAL_ALLO
C 

ALLOCATE CheckPartialAllocatio
n 

CheckValidAllocation 

PARTIAL_ALLO
C 

Transition for partially completing 
the allocation of a partially allocated 
trade. 

VERIFIED PROPAGAT
E 

  VERIFIED Transition allowing block trade 
amendments to be applied to 
children. 

This action name must be set in 
domain 
PropagateBlockTradeChangesActio
n. 

VERIFIED AMEND NotAllocationChild VERIFIED Transition for rejecting direct 
amendments to child trades. - 
See Modification of Child Trades for 
details. 

VERIFIED UPDATE NotAllocationChild VERIFIED Transition for rejecting direct 
update of child trades. - 
See Modification of Child Trades for 
details. 

ALLOCATED TERMINATE   TERMINATED Transition for terminating a block 
trade and all its children. 

ALLOCATED NOVATION   TERMINATED Transition for novating a block trade 
and all its children. 

ALLOCATED CANCEL   CANCELED Transition for canceling a block 
trade and all its children. 

 

https://www.calypso.com/download/helpdesk_test1/documents/rel1300/docs/Subsystems/TradeLifecycle/Content/AllocationWorkflow.htm#Modifica
https://www.calypso.com/download/helpdesk_test1/documents/rel1300/docs/Subsystems/TradeLifecycle/Content/AllocationWorkflow.htm#Modifica
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4 IBM MQ and JMS Support 
The Data Uploader provides the ability to read messages from real-time messaging systems such as, IBM MQ or 
Active MQ, using the JMS API. 

 NOTE: Calypso supports IBM MQ version 7 and above. 

The Data Uploader uses the Upload Import Message for event handling and message processing. An event is 
created in Calypso for each received message, which is listened for and then processed by the Uploader Import 
Message engine, thus providing the ability to asynchronously process messages. 

Information received from the queues is in the form of XML-formatted string messages. Calypso’s Import engines 
support XML-messages that use the Data Uploader-specific CalypsoUploadDocument format. 

The following setup is required to support the Data Uploader’s usage of MQ and JMS. 

 

Step 1 - Install IBM MQ Series. 

In addition to installing MQ series, you need to obtain the following JARs from IBM: 

• com.ibm.mq.commonservices_7.0.1.3.jar 

• com.ibm.mq.jar 

• com.ibm.mqjms.jar 

• com.ibm.mq.pcf.jar 

• dhbcore.jar 

• com.ibm.mq.headers.jar 

• com.ibm.mq.jmqi.jar 

• com.ibm.mq.jms.Nojndi.jar 

• connector.jar 

• fscontext.jar 

• jms.jar 

• jndi.jar 

• provideerutil.jar 

 

These files need to be added to the Calypso Installer to “Common Third Party Libraries & Extensions”: 
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Step 2 - Launch MQ Explorer and create the following objects: 

• Queue Manager 

• Input Queue 

• Output Queue 

 

Note that you will need each of these object names in a later step. 

 

Step 3 - Generate the Bindings file as explained below. The Bindings file is used as the PROVIDER_URL to connect 
to the Middleware. 

Modify the file “UploaderJMSAdmin.config”. 

Update the PROVIDER_URL property as necessary for your implementation. This is the path to the bindings file: 

PROVIDER_URL=file:/usr/local/calypso/resources/uploader 

Update the SECURITY_AUTHENTICATION property as needed to the authentication model: None, simple, or 
CRAM_MD5. 

SECURITY_AUTHENTICATION=none 

 

Step 4 – Modify “calypso home/client/bin/uploaderMQSeries.bat” on Windows platforms or “calypso 
home/client/bin/uploaderMQSeries.sh” on *nix platforms. 

Change the highlighted text to match the object names you have created in Step 2. 

• QM_Name = Your Queue Manager 

• InputQueueName = Your Input Queue 
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• OutputQueueName = Your Output Queue 

 

echo + Creating script for object creation within JMSAdmin 

echo del qcf(QueueConnectionFactory) > uploadermqsetup.scp 

echo del q(OutputQueueName) >> uploadermqsetup.scp 

echo del q(InputQueueName) >> uploadermqsetup.scp 

echo def qcf(QueueConnectionFactory) qmgr(QM_Name) >> uploadermqsetup.scp 

echo def q(OutputQueueName) qu(OutputQueueName) qmgr(QM_Name) tc(JMS)>> uploadermqsetup.scp 

echo def q(InputQueueName) qu(InputQueueName) qmgr(QM_Name) tc(JMS)>> uploadermqsetup.scp 

echo end >> uploadermqsetup.scp 

 

Step 5 - Run “calypso home/client/bin/uploaderMQSeries.bat” on Windows platforms or “calypso 
home/client/bin/uploaderMQSeries.sh” on *nix platforms. 

 

Step 6 – Run the Uploader Import Message engine, the Sender engine, and the Update Manager engine if 
uploadMode = Local, and persistMessages=All or persisteMessages =Failure 

 

 NOTE: Connection to the IBM MQ can be done by 2 ways: 

1. Binding file approach – Here connection established is of type CONNX. 

2. Property file. 

 In both the cases retry and delay functionality are supported. 

 

The Uploader Import Message engine and the Sender engine can be started from the Engine Manager in Web 
Admin. 

 

 Please refer to Calypso Web Admin documentation for complete details. 

 

Processing 

The Uploader Import Message engine is now listening to messages from the MQ input queue. 

The Sender engine is now listening to Message Events. 

When a Message of a configured type reaches a particular state, the Sender engine processes the message and 
sends an Acknowledgement to the MQ output queue. 

The engines use the file “calypso_uploader_config.properties” to connect to the MQ input and output 
queues. 
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While sending the messages to IBMMQ/ActiveMQ, user can provide the list the properties in the property file that 
need to be send as a message header tested for GatewayUploaderDocumentSender and 
GatewayJMSDocumentSender. 

For example, if the message needs to be sent by JMS Document sender, then in the 
"calypso_reporthub_config.properties" file user can specify the headers as follows: 

jms.header.TenantId=01422406 

jms.header.SourceSystemName=Calypso 

jms.header.AssetClass=Calypso_IR_Intraday 

 

 

For GatewayUploaderDocumentSender, calypso_uploader_config file will be used with the header properties: 
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In the MQ if we check the message we should see the headers like below TenantId: 

 

 

JMX Support 

JMX is disabled by default using environment property DU_MESSAGING_SERVER_USE_JMX = false. 

When DU_MESSAGING_SERVER_USE_JMX = false, you need to set RISKCONTROL_TELEMETRY_DISABLE = true. 

 

JMX management can be enabled by setting DU_MESSAGING_SERVER_USE_JMX = true. 
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When DU_MESSAGING_SERVER_USE_JMX = true, the Data Uploader tries to setup a remote JMX. The environment 
property DU_MESSAGING_SERVER_USE_REMOTE_JMX = false (default) allows preventing the Data Uploader to 
setup a remote JMX. 

If DU_MESSAGING_SERVER_USE_REMOTE_JMX = true, environment properties 
DU_MESSAGING_SERVER_JMX_HOST (default is localhost) and DU_MESSAGING_SERVER_JMX_PORT (default is 
2001) control which host, and port are used for the remote JMX. 
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5 Source Message Workflow 
The Data Uploader also provides dual- message capability similar to that found in the Calypso Exchange Feed 
module. 

The Calypso Exchange Feed module implements a dual-message workflow. Markitwire however lacks this feature 
and can miss critical information from the data source if the item is not mapped (Book, PO, etc.). In this event, the 
source message is “lost” and must be replayed. 

Dual message workflow allows Calypso to store Source Messages for Audit and Tracking purposes, as well as for 
replay via the Task Station rather than a scheduled task. 

DS-Match (CCP) and ICELink also use the Dual Message workflow and Upload Source Message. 

 NOTE: This change is mandatory for Calypso’s Markitwire module beginning with V2.3.12+, V2.9.3+, 
V3.0.2+) 

5.1 Implementation 

When the Data Uploader receives a message from the source interface, it creates a Source BO Message and stores 
the Incoming Message, itself, as a payload so that messages received from the source are never lost. 

Dual message support requires you to import the “UPLOADSOURCEMSG.wf” workflow. In addition, you must import 
an updated GATEWAYMSG workflow using “GATEWAYMSG.wf”. 

You can import these workflows as described for the GATEWAYMSG workflow earlier in the document. 

UPLOADSOURCEMSG Workflow 
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The UPLOADSOURCEMSG workflow does the following: 

• Translates the Source Message. If the Translation fails, the BO Message stops with a RECEIVED status. This 
blocked BO Message also blocks any further messages related to the same Source ID. 

• If the Translation succeeds, a second BO Message is created. The second message is for Validation of the 
Translated message. It also creates the Trade in Calypso. 

Updated GATEWAYMSG Workflow 

 

 

When Calypso acts with the CCP role, the following workflow rules link both party’s messages and combine them. 
These additional rules are not required for TRADER Role. 

• BACKLOAD - BACKLOAD - PENDING_VALID 
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• PENDING_VALID - REJECT - REJECTED 

 

Static data filter “ RejectedMessage”: 
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• PENDING_VALID - VALIDATE - PENDING_TRADE 

 

Static data filter “ValidMessage”: 
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Message Report - DSMATCH 

 

When you double-click an UPLOADSOURCEMSG message, the document viewer displays the source message and 
the translated UploadXML simultaneously. 
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The document viewer displays the source message in the left-hand panel and the translated UploadXML in the 
right-hand panel. By default, if a second level UPLOADSOURCEMSG exists, the right-hand panel is populated with 
its contents. If it does not exist, then the application performs a run-time translation. If an error occurs during run-
time translation, then the application leaves the right-hand panel empty. 

When you double-click a GATEWAYMSG message, the document view only displays the translated document, as 
shown below. 
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5.2 Benefits 

Dual Message handling provides the following benefits: 

• The system does not lose track of source messages when a mapping is incorrect. 

• Messages are linked if they fail translation, blocking further life cycle actions. 

• A separate Replay Scheduled Task (i.e., DoRecovery) is not required for messages experiencing a translation 
error. For example, if a particular Book is missing or not mapped, there is no longer a need to run a 
DoRecovery. 

• The application can potentially eliminate some FORCE_NEW/ FORCE_AMEND DoRecovery, since translation 
will is accurate as per the Trade status in Calypso. 
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5.3 Task Station Configuration 

UPLOADSOURCEMSG 

 

 

MWGATEWAYMSG 
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DSMATCH 
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6 Exporting Quotes 
The EXPORT_QUOTES scheduled task provides the ability to export stored quotes from one Calypso system into 
files which further can be used to import these quotes into another Calypso system. It allows: 

• Ability to specify which quotes to include/exclude in the output 

• Range of dates for export 

• Multiple output formats (i.e. csv, xml) 

 

Out of Scope 

• Custom output templates/formatting 

• Full dump of all quotes will not be allowed; number of lines will be capped 

• Calypso report inside of Navigator (including CWS, Risk Config, new GUI, etc) 

• No usage of Pricing Environments or trade population to select relevant quotes 

• No leveraging of Quote Set dependency graph; given Quote Set is used as is 

6.1 Configuration 

6.1.1 Domain Value 

Check if EXPORT_QUOTES is present in “scheduledTask” domain. This will be already present if 
GatewaySchemaData.xml has been executed using Execute SQL. 

If the scheduled task entry is not present in the domain, then either add it manually or run the latest 
GatewaySchemaData.xml. 

 

6.1.2 Scheduled Task 

Step 1 – From the Calypso Navigator, navigate to Configuration > Scheduled Tasks. 

 

Step 2 – In “Task and Schedule Configuration” tab under task Definitions select New Task. Enter 
“EXPORT_QUOTES” as the Task Type, enter the attributes, and Save the configuration. 
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Task Attributes 

• NAME – This mandatory input is a drop-down of all the available product codes (Name/ISIN/CUSIP/etc). By 
default “Name” is used. 

• QUOTE SET – This mandatory input is a string that must match exactly to a defined Quote Set in the system 
(BackOffice/default/OFFICE/etc). Only this specific Quote Set will be exported in the process, meaning no 
parent Quote Sets will be picked up and exported in the case of a defined hierarchy. 

• START DATE and END DATE – These fields are optional - not entering a date implies only exporting for the Val 
Date. This input must be defined in a fixed format (i.e. yyyy-MM-dd, for example “2016-10-23”), it will not follow 
the environment or user locale. Start Date and End Date (Val Date) are inclusive in the date range. 

• INCLUDE QUOTE NAMES LIKE – This mandatory input will serve as criteria to search quotes with the provided 
name. Exact quote names can be entered, or a wildcard operator [*] can be leveraged for more general 
selections. Multiple quotes name can be entered, separated by semicolons. 

• EXCLUDE QUOTE NAMES LIKE – The input provided will serve as criteria to exclude quotes with the provided 
name. Exact quote names can be entered, or a wildcard operator [*] can be leveraged for more general 
selections. Multiple quotes name can be entered, separated by semicolons. 

• OUTPUT FILE TYPE – This mandatory input will specify the format in which quotes will be exported, either CSV 
or XML. 

• OUTPUT FILE PREFIX – This field is optional and the file exported will be prefixed with this input. By default, 
“QUOTES_REPORT” will be prefixed when the input is not provided. The file generated will have this prefix 
appended with a timestamp and extension format (i.e. QUOTES_REPORT_20160803.xml). 

• OUTPUT FILE LOCATION – This mandatory input will provide the directory path used to write the exported 
quotes record. It must be a valid directory path with access permission to write. 

• UTPUT FILE NAME DATE FORMAT – Enter the date format for the file name as needed - Example 
ddMMyyyyHHmm. 
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• EXCLUDE TIMESTAMP IN FILE NAME - It is FALSE by default. When set to TRUE, the timestamp is not 
appended to the file name. If the scheduled task is run multiple times, the file is overwritten in that case. 

• EXCLUDE MATURED PRODUCTS 

• SEND REPORT BY EMAIL TO – Enter the email addresses (comma separated) to send the report as "To" (see 
also RECEIVER Legal Entity / Receiver LE Contact Type below for more information). 

• SEND REPORT BY EMAIL CC - Enter the email addresses (comma separated) to send the report as "Cc". 

• RECEIVER Legal Entity / Receiver LE Contact Type - Select the legal entity and LE contact that should receive 
the email (email address specified on the LE contact). If not set, the email is sent to the email addresses 
specified in "SEND REPORT BY EMAIL TO". 

• SENDER LE contact Type - Select the LE contact (of the scheduled task's Processing Org) that should send the 
email (email address specified on the LE contact). 

 

The email subject line and content can be populated using the following property files (the naming of the property 
files is based on Sender PO/Receiver Legal Entity): 

EmailREPORT<report type>_<Sender PO>-<Receiver Legal entity>.properties 

Example: 

EmailREPORTMARKET_QUOTE_CALYPSO_SFO-AAA BANK.properties  

 

Step 3 – After saving an instance of the created scheduled task will be created as shown below that could be 
executed by selecting and clicking the Run button. 

 

6.2 Limitation and Alerts 

6.2.1 Quotes Records 

To limit the size of the reports for performance optimization, constraints are placed around the exporting process. 

If the quotes criteria fetch records which are greater than the defined limit, then an error message will alert the user 
to kindly reduce the search criteria to generate a more manageable report size. By default, 100,000 is the count 
used to limit the quotes fetch when the property is not specified in calypso user environment property file. 
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Clients must demonstrate an atypical and valid use case to qualify for the environment property which overrides 
the default limit. Please raise a Help Desk if this situation applies. 

6.3 File Split 

To limit the number of quotes in a single file for some given quote search criteria, the total number of quotes record 
fetched are segregated and written into multiple files. 

For this purpose, the user needs to configure a domain “NumberOfQuotesPerFile” and must specify the maximum 
number of records needed to be written in a single file. In conditions when the quote records fetched are less than 
the domain value entry then the records will be written in a single file. 

 

6.4 Typical Use Cases 

6.4.1 Examples and Notes 

1. Extract All Equity Quotes for the Current Day: 

a. Include Quotes Like: Equity.*;EquityIndex.* 

b. Exclude Quotes Like: empty 

c. Start Date = NULL 

 
2. Extract All Quotes for GOOG Since 2010 

a. Include Quotes Like: Equity.GOOG 

b. Exclude Quotes Like: 

 
3. Commas are NOT valid separators. The only valid separator when defining the quotes to export is a 

semicolon ( ; ). 

a. Per common market convention, commas, spaces, slashes, etc. are valid in Quote Names. This 
would therefore break the export functionality in any of these cases. 
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7 Client Channel Definition Table (CCDT) - IBM 
MQ 
This section will describe how to create and use a Client Channel Definition Table (CCDT) for a Queue Manager 
and a Queue Manager Group in WebSphere MQ. 

A CCDT defines client connection channels and their attributes. Clients read this file to determine which queue 
managers they should connect to. The CCDT file can be either JSON or binary format. The queue manager does 
not read the CCDT file. It is only used to provide clients with channel definitions and authentication information. 

From IBM® MQ 9.1.2, you can create a CCDT in JavaScript Object Notation (JSON) format, and this format has 
some advantages over binary CCDT. 

A binary format CCDT is created automatically when a queue manager is created. The runmqsc command is used 
to update the client channel definitions stored in this table. 

 

Binary Format 

• The queue manager creates a binary CCDT automatically in the @ipcc directory under the data directory. 

• The binary CCDT associated with a queue manager is not only created automatically, but also kept in sync with 
the object definitions. When you create, modify, or delete a client channel object, both the queue manager 
object definition and the entry in the CCDT are updated at the same time. 

• The CCDT is created in the location indicated by MQCHLLIB and with the filename indicated by MQCHLTAB, 
which is AMQCLCHL.TAB by default. You can change the path to the CCDT by setting MQCHLLIB. Keep in 
mind that if you have multiple queue managers on the same server, they will share the same CCDT location. 

 

JSON Format 

• There is no default JSON CCDT. IBM MQ does not provide any tooling to create or edit CCDTs in JSON format. 
However, you have more configuration options when you manually develop a JSON CCDT than when you use 
the runmqsc command to work with a binary CCDT. 

• A JSON format CCDT is a flat text file with a .json extension. You create and update this table manually. 

• Some of the advantages of using JSON CCDT files are as follows: 

− You do not need IBM MQ for Multiplatforms to create and edit a JSON CCDT file. 

− Using the JSON format, you can define duplicate channel definitions of the same name. You can use 
this to make your IBM MQ deployment scalable and highly available when you deploy it on the cloud. 

− The JSON file is human readable, which make queue manager configuration easier. 

− A flat file format can be integrated with: 

Version control tooling to track the CCDT history 

Automation tooling in continuous delivery 
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− You don't need any special tool to maintain the CCDT file. 

− The file size is smaller. 

− This format provides backwards and forwards compatibility. 

 

Location of CCDT 

• BM® MQ supports retrieving a CCDT from a file, FTP, or HTTP URL. You can make the CCDT accessible to the 
client as a shared file, while it remains located on the server. Alternatively, you can distribute the CCDT, by 
either copying the CCDT to individual client or copying the CCDT to a location shared by multiple clients. 

• If you use FTP to copy the file, use the bin option to set binary mode; do not use the default ASCII mode. 
Whatever method you choose to make the CCDT available, the location must be secure to prevent 
unauthorized changes to the channels. 

• Both authenticated and unauthenticated URLs are supported. Here are some examples: 

− URL=ftp://myuser:password@myhost.sample.com//var/mqm/qmgrs/QMGR/@ipcc/AMQCLCHL.TAB 

− URL=http://myuser:password@myhost.sample.com/var/mqm/qmgrs/QMGR/@ipcc/AMQCLCHL.TAB 

− URL=ftp://myhost.sample.com//var/mqm/qmgrs/QMGR/@ipcc/AMQCLCHL.TAB 

− URL=http://myhost.sample.com/var/mqm/qmgrs/QMGR/@ipcc/AMQCLCHL.TAB 

 

CCDT with IBM MQ classes for JMS 

• To use a client channel definition table, the CCDTURL property of a ConnectionFactory object must be set to a 
URL object. 

• The URL object encapsulates a uniform resource locator (URL) that identifies the name and location of the file 
containing the client channel definition table and specifies how the file can be accessed. 

• An application can set the property by creating a URL object and calling the setCCDTURL() method of the 
ConnectionFactory object. 

• For example, if the file ccdt1.tab contains a client channel definition table and is stored on the same system on 
which the application is running, the application can set the CCDTURL property in the following way: 

java.net.URL chanTab1 = new URL("file:///home/admdata/ccdt1.tab"); 

factory.setCCDTURL(chanTab1); 

Another example, suppose the file ccdt2.tab contains a client channel definition table and is stored on a 
system that is different from the one on which the application is running. If the file can be accessed using 
the FTP protocol, the application can set the CCDTURL property in the following way: 

java.net.URL chanTab2 = new URL("ftp://ftp.server/admdata/ccdt2.tab"); 

factory.setCCDTURL(chanTab2); 

1. It is necessary to define 2 channels with the SAME name: one server-connection channel (SVRCONN) 
and one client-connection channel (CLNTCONN). 

2. The CCDT file is updated ONLY when the client-connection channel is created or changed. 
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• In addition to setting the CCDTURL property of the ConnectionFactory object, the QMANAGER property of the 
same object must be set to one of the following values: 

− The name of a queue manager 

− An asterisk (*) followed by the name of a queue manager group 

− An application can set the property by calling the setQueueManager() method of the 
ConnectionFactory object. 

factory.setQueueManager("QM"); 

• If an application then creates a Connection object from the ConnectionFactory object, IBM MQ classes for JMS 
accesses the CCDT identified by the CCDTURL property, uses the QMANAGER property to search the table for 
a suitable client connection channel definition, and then uses the channel definition to start an MQI channel to a 
queue manager. 

• Note that the both CCDTURL and CHANNEL properties of a ConnectionFactory object cannot be set when the 
application calls the createConnection() method. If both properties are set, the method throws an exception. 
The CCDTURL or CHANNEL property is set if its value is anything other than null, an empty string, or a string 
containing all blank characters. 

7.1 Queue Manager Groups 

A Queue Manager Group is a set of connections in the client channel definition table (CCDT). The set is defined by 
its entries having the same value of the QMNAME attribute in their channel definitions. You can connect an 
application to a queue manager that is part of a queue manager group. 

Some of the reasons for choosing to use a Queue Manager Group are as follows: 

• You want to connect a client to any one of a set of queue managers that is running, to improve availability. 

• You want to reconnect a client to the same queue manager it connected to successfully last time but connect 
to a different queue manager if the connection fails. 

• You don't need to write any client code, to automatically reconnect a client connection to another queue 
manager if the connection fails. 

• You don't need to write any client code, to automatically reconnect a client connection to a different instance 
of a multi-instance queue manager if a standby instance takes over. 

• You want to balance your client connections across several queue managers, with more clients connecting to 
some queue managers than others. 

• You want to distribute the reconnection of many client connections over multiple queue managers and over 
time, in case the high volume of connections causes a failure. 

• You want to be able to move your queue managers without changing any client application code. 

• You want to write client application programs that do not need to know queue manager names. 

When to use a leading asterisk in the name of the queue manager group – 

You can connect an application to a queue manager that is part of a queue manager group, by prefixing the queue 
manager name on an MQCONN or MQCONNX call with an asterisk. 
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When a queue manager group has a single entry and the names of the group and the entry are the same, then it is 
ok to only the name of the queue manager and not using the asterisk as a prefix. 

However, when the group has multiple entries or the group name is different than the single entry, it is necessary 
to specify the group name with a leading asterisk. 

Following are the scenarios for which we will give an example: 

Scenario 1 - Simplest case, using same QMNAME for a single queue manager (QM3 in host1) 

Scenario 2 - Queue Manager Group: QM1 (no leading asterisk) 

Create following Queue Managers 

host-1: QM1, QM2, QM3 

host-2: QM1, QM2, QM3, QM4 

Use following command to create Queue Manager: 

crtmqm <QueueManagerName> 

strtmqm <QueueManagerName> 

The following table is created in order to provide more specific information on the queue managers and channel 
names. 

Scenarios Queue Manager 
Group 

QMNAME 

Queue Manager 
Name 

Hostname Port Channel 
Name 

Scenario 1 - Simplest 
case - using 
QMNAME (QM3) for 
queue manager 
(QM3) in host-1 

QM3 QM3 localhost 1451 QM3 

Scenario 3 - Queue 
Manager Group: 
QM1 (no leading 
asterisk) 

QM1 

QM1 

QM1 

QM1 

localhost 

10.17.35.138 

1431 

1425 

QM1.A 

QM1.B 

 Note:  

• Please do following steps for each Queue Manager 

• Right click on the <QueueManager> - “Properties” - “Extended” - “Connection Authentication” - Remove 
“SYSTEM.DEFAULT.AUTHINFO.IDPWOS” 

• Go to Communication property on left hand panel - Channel Authentication Records - Disabled 

• Then run following commands to refresh: 

runmqsc <QueueManagerName> 

refresh security type(CONNAUTH) 
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refresh security type(AUTHSERV) 

refresh security type(SSL) 

 Ensure that all the above commands are executed whenever configuration on MQ Explorer is modified. 

 Please do the following steps after a Listener is created. 

• Specify MCA user as MUSR_MQADMIN 

• Expand Channel - Channel Authentication Records - Right Click Highlighted Block User List Type – Delete 

Create following Queues: 

DEFINE QLOCAL(Q9) REPLACE 

DEFINE QLOCAL(SOURCE) REPLACE 

DEFINE QLOCAL(TARGET) REPLACE 

 

runmqsc QM3 

DEFINE CHANNEL(QM3) CHLTYPE(SVRCONN) TRPTYPE(TCP) REPLACE 

DEFINE CHANNEL(QM3) CHLTYPE(CLNTCONN) TRPTYPE(TCP) CONNAME('localhost(1451)') QMNAME(QM3) REPLACE 

DEFINE LISTENER (L3) TRPTYPE(TCP) PORT(1451) REPLACE 

Exit 

CCDT 

{ 

  "channel": 

  [ 

    { 

      "general": 

      { 

        "description": "cahnnel1" 

      }, 

      "name": "QM3", 

      "clientConnection": 

      { 

        "connection": 

        [ 

          { 

            "host": "127.0.0.1", 

            "port": 1451 

          } 

        ], 

        "queueManager": "QM3" 

      }, 
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      "type": "clientConnection" 

    } 

  ] 

} 

 

host-1: 

runmqsc QM1 

DEFINE CHANNEL(QM1.A) CHLTYPE(SVRCONN) TRPTYPE(TCP) REPLACE 

DEFINE CHANNEL(QM1.A) CHLTYPE(CLNTCONN) TRPTYPE(TCP) CONNAME('localhost(1431)') QMNAME(QM1) REPLACE 

DEFINE LISTENER (L1A) TRPTYPE(TCP) PORT(1431) REPLACE 

exit 

host-2: 

runmqsc QM1 

DEFINE CHANNEL(QM1.B) CHLTYPE(SVRCONN) TRPTYPE(TCP) REPLACE  

DEFINE CHANNEL(QM1.B) CHLTYPE(CLNTCONN) TRPTYPE(TCP) CONNAME('localhost(1425)') QMNAME(QM1) REPLACE 

DEFINE LISTENER (L1B) TRPTYPE(TCP) PORT(1425) REPLACE 

exit 

CCDT 

{ 

  "channel": 

  [ 

    { 

      "general": 

      { 

        "description": "cahnnelQM1A" 

      }, 

      "name": "QM1.A", 

      "clientConnection": 

      { 

        "connection": 

        [ 

          { 

            "host": "127.0.0.1", 

            "port": 1431 

          } 

        ], 

        "queueManager": "QM1" 

      }, 

      "type": "clientConnection" 

    }, 
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    { 

      "general": 

      { 

        "description": "channelQM1B" 

      }, 

      "name": "QM1.B", 

      "clientConnection": 

      { 

        "connection": 

        [ 

          { 

            "host": "10.17.35.138", 

            "port": 1425 

          } 

        ], 

        "queueManager": "QM1" 

      }, 

      "type": "clientConnection" 

    } 

  ] 

} 
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8 Kafka Support 
The Data Uploader provides the ability to receive and send data from kafka server using kafka adapter that can be 
plugged in by importmessage engine and sender engine. 

The name of the adapter is “CalypsoKafkaIEAdapter”, which can be called from IEAdapterConfig. 

This is similar to a queue in JMS. So, using the adapter our program can become a producer (send data to topic) or 
consumer (receive data from a specific topic). For connection and configuration we have added new properties 
that should be provided in 'calypso_<config_name>_config.properties file. 

• kafka.consumercount=2  

• We can create multiple consumers that will work in a group (consumer group) to receive data. 

• Also, each consumer will run in a separate thread. 

• kafka.consumertopic=inputnew 

• Name of the topic consumer will subscribe to 

• kafka.producertopic=outputnew 

• Name of the topic producer will subscribe to 

• kafka.producerdatakey=calypsoimportmrssageenine 

Apart from this the properties that are needed to be provided to Kafka configuration can be done in following ways: 

For consumer the name of the property should start with “consumer.” 

e.g. 

• kafkaconsumer.bootstrap.servers=localhost:9093 

• kafkaconsumer.security.protocol=SSL 

• kafkaconsumer.ssl.truststore.location=C:\\kafka\ssl\kafka.server.truststore.jks 

• kafkaconsumer.ssl.truststore.password=calypso 

• kafkaconsumer.ssl.keystore.location=C:\\kafka\sslclient\kafka.client.keystore.jks 

• kafkaconsumer.ssl.keystore.password=calypso 

• kafkaconsumer.ssl.key.password=calypso 

For producer, the name of the property should start with “producer.” 

e.g. 

• kafkaproducer.security.protocol=SSL 

• kafkaproducer.ssl.truststore.location=C:\\kafka\ssl\kafka.server.truststore.jks 

• kafkaproducer.ssl.truststore.password=calypso 

• kafkaproducer.ssl.keystore.location=C:\\kafka\sslclient\kafka.client.keystore.jks 

• kafkaproducer.ssl.keystore.password=calypso 

• kafkaproducer.ssl.key.password=calypso 



Nasdaq Calypso 
Data Uploader Integration Guide / Version 15 – Version 18 

 

 

 

 

May 2025 Revision 39.0 / Approved Page 83 / 86 
Private and Confidential 

 

If the properties for producer and consumer are same, then instead of providing separately we can provide the 
common properties as follows: 

• kafkaclient.security.protocol=SSL 

• kafkaclient.bootstrap.servers=localhost:9093 

 

We can connect to kafka with authentication, encryption, and authorization on. In the following examples we will 
see the properties needed for producer and consumer to connect to kafka server with different types of 
authentications and encryptions. 

1. Plaintext connection - without authentication and encryption 

2. SSL encryption 

3. SSL Authentication  

4. SASL (Simple Authentication and Security Layer) 

a. SSL 

b. Plaintext 

 

SSL Encryption 

For SSL we need to create self-signed certificates and keystore & truststore. 

In the kafka server.properties file we need to specify the following properties to enable the encryption 

• listeners=SSL://0.0.0.0:9093 

• advertised.listeners=SSL://localhost:9093 

• ssl.keystore.location=C:\\kafka\\ssl\\kafka.server.keystore.jks 

• ssl.keystore.password=calypso 

• ssl.key.password=calypso 

 

#trustore information is also needed here so that different components of kafka can communicate with each other 

• ssl.truststore.location=C:\\kafka\\ssl\\kafka.server.truststore.jks 

• ssl.truststore.password=calypso 

• inter.broker.listener.name=SSL 

To clients (producers and consumers) we can provide these trustore and password which they can use or that can 
create a separate trustore and add the certificate in their trust store. 

To start the producer and consumer from console for testing we need to add following properties In 
consumer.properties and producer.properties. 

• security.protocol=SSL 

• ssl.truststore.location=C:\\kafka\\ssl\\kafka.server.truststore.jks 
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• ssl.truststore.password=calypso 

 

Command to start producer and consumer by providing the config file in command line is as follows: 

• bin\windows\kafka-console-producer.bat --broker-list localhost:9093 --topic test --producer.config 
config/producer.properties 

• bin\windows\kafka-console-consumer.bat --bootstrap-server localhost:9093 --topic test --consumer.config 
config/consumer.properties 

 

SSL Authentication 

Client can also have their certificates by which server can identify them and hence we will achieve authentication 
as the server will know the identity of the client. 

In the encryption case: 

• Only the brokers have signed servers’ certificates. 

• The client was verifying the broker certificates to establish an SSL connection. 

• The client is "anonymous" to the broker (no identity). 

In the authentication case: 

• The clients AND the brokers have signed server certificates. 

• The client and the brokers verify each other's certificates. 

• The client now has an IDENTITY to the broker (We can apply ACLs). 

 

After creating client side certificate and truststore, we can enable the authentication in the server.properties file by 
adding the following line: 

ssl.client.auth=required 

Now since the authentication is on, the client will have to pass following properties: 

• security.protocol=SSL 

• ssl.truststore.location=C:\\kafka\ssl\kafka.server.truststore.jks 

• ssl.truststore.password=calypso 

The above properties were already set before, which was used for encryption. Now we also need the following 
properties for authentication: 

• ssl.keystore.location=C:\\kafka\sslclient\kafka.client.keystore.jks 

• ssl.keystore.password=calypso 

• ssl.key.password=calypso 
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SASL 

For SASL we create users in kafka. The users are specified in the jaas config file. 

Add the zookeeper_jaas.conf file to the environment variable KAFKA_OPTS before starting zookeeper. And start the 
Zookeeper. 

In another window shell terminal add the kafka_server_jaas.conf file to the environment variable KAFKA_OPTS 
before starting kafka server. Before starting the kafka server we need to update the property file so that various 
authentication and encryption are enabled. 

The following server.properties file has the configuration for the following type of connections that will work with 
different ports. 

• PLAINTEXT - port: 9092 

• SSL - port: 9095 

• SASL PLAINTEXT - port: 9093 

• SASL SSL - port: 9094 

 

Once the server is started, we can connect the producers and consumers to different ports with different 
configurations that are needed for that specific port. 

1. We connect to port 9092 where there is no authentication and no encryption i.e. PLAINTEXT 

a. start the producer and consumer - no property file needed here 

b. The producer and consumer are connected to port 9092 and the message is successfully delivered. 

2. We connect to port 9095 where only SSL is enabled with authentication. Start the producer and consumer 
with following properties: 

bin\windows\kafka-console-producer.bat --broker-list localhost:9095 --topic test --producer.config 

config/producer-SSL_AUTH.properties 

bin\windows\kafka-console-consumer.bat --bootstrap-server localhost:9095 --topic test --

consumer.config config/consumer-SSL_AUTH.properties 

3. We connect to port 9093 where SASL PLAINTEXT is configured. Start the producer and consumer with 
following properties: 

bin\windows\kafka-console-producer.bat --broker-list localhost:9093 --topic test --producer.config 

config/producer-SASL_PLAINTEXT_AUTH.properties 

bin\windows\kafka-console-consumer.bat --bootstrap-server localhost:9093 --topic test --

consumer.config config/consumer-SASL_PLAINTEXT_AUTH.properties 

4. We connect to port 9094 where SASL-SSL is configured. Start the producer and consumer with following 
properties: 

bin\windows\kafka-console-producer.bat --broker-list localhost:9094 --topic test --producer.config 

config/producer-SASL_SSL.properties 

bin\windows\kafka-console-consumer.bat --bootstrap-server localhost:9094 --topic test --

consumer.config config/consumer-SASL_SSL.properties 
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Connecting to kafka server using the CalypsoKafkaIEAdapter. 

In calypso_uploader_config.properties file we have configuration for producer and consumer. 

Consumer is connected to port 9094 with SASL_SSL and Producer is connected to port 9095 with SSL 2-way 
authentication. We use this file in UploadImportMessageEngine and we are able to consume data from ‘inputnew' 
topic and send the data to 'outputnew’ topic. 

 

 

 


